CONNECTICUT DEPARTMENT OF TRANSPORTATION

AEC Applications – Division of Facilities & Transit

CTDOT

*MicroStation* V8i Guide for Highway Designers
Table of Contents

INTRODUCTION........................................................................................................................................ 5

SECTION 1 GETTING STARTED.................................................................................................................. 7
  1.1 Opening MicroStation through Accounting......................................................................................... 7
  1.2 Creating a User Interface & Configuration Files................................................................................. 8
  1.3 Selecting a Project Configuration......................................................................................................... 10
  1.4 Selecting the Correct Seed File........................................................................................................... 12
  1.5 MicroStation Design Model File Conventions.................................................................................... 14
    1.5.1 Utilizing InRoads and MicroStation for 3D Design...................................................................... 14
      1.5.1.1 Profile and Cross Sections for 3D Design.............................................................................. 17
    1.5.2 Utilizing InRoads and MicroStation for 2D Design...................................................................... 17
    1.5.3 Utilizing MicroStation and some InRoads for 2D Design................................................................. 18
  1.6 MicroStation Sheet File Conventions.................................................................................................. 21
    1.6.1 Geo-Referenced Cut sheet.............................................................................................................. 21
    1.6.2 Detail Sheet..................................................................................................................................... 22
  1.7 Levels................................................................................................................................................... 23
    1.7.1 Standard Level Naming Convention............................................................................................. 23
    1.7.2 Non-Standard Level....................................................................................................................... 24

SECTION 2 MICROSTATION - DESIGN MODELS ................................................................................. 25
  2.1 Creation of a 3D Design Model ............................................................................................................. 25
  2.2 Creation of a 2D Design Model ............................................................................................................. 30
  2.3 Drawing in the 2D Design Model.......................................................................................................... 32
    2.3.1 Roadway Tasks................................................................................................................................. 34
    2.3.2 Safety & Fences Tasks..................................................................................................................... 35
    2.3.3 Rights Of Way (ROW) Tasks........................................................................................................... 35
    2.3.4 Construction Staging....................................................................................................................... 36
  2.4 InRoads Storm & Sanitary....................................................................................................................... 37
    2.4.1 Plan View......................................................................................................................................... 37
    2.4.2 Profile.............................................................................................................................................. 39
    2.4.3 Cross Sections.................................................................................................................................. 40
  2.5 Drafting Drainage when using StormCAD............................................................................................. 41
MicroStation V8i Guide for Highway Designers

2.5.1 Plan View ........................................................................................................41
  2.5.1.1 Drainage Plan Tasks ..............................................................................41
  2.5.1.2 Pipes and Ends ......................................................................................42
2.5.2 Drainage Profile .............................................................................................43
2.5.3 Drainage Cross Sections (XSC) ....................................................................44

SECTION 3 GEO-REFERENCED SHEET MODELS ................................................. 45
  3.1 Create Sheet Model & Attach Reference ...................................................... 45
  3.1.1 Create Sheet Model ..................................................................................45
  3.1.2 Attach Reference File ..............................................................................45
  3.1.3 Update Sequence in Reference File .........................................................48
  3.2 Place Plan Border and Transient Shape .....................................................51
  3.2.1 Plan Border Cell Placement ....................................................................51
  3.2.2 Placing Transient Shape .........................................................................55
  3.3 Border Title Block Information ...................................................................57
  3.4 Creating Saved View ....................................................................................59

SECTION 4 DETAIL SHEET MODELS ................................................................. 61
  4.1 Creating a Detail Sheet Model .......................................................................61
  4.2 Using InRoads Templates as Typical Section ..............................................62
  4.3 Contract Sheet Annotation ......................................................................... 65
  4.3.1 Call Outs ..................................................................................................66
  4.3.1.1 Pay Item General and Pay Item Drainage ...........................................66
  4.3.1.2 Non-Pay Item, Paid By Others and ROW Call Out .........................68
  4.3.1.3 See Drawing XX-## Callout .................................................................70
  4.3.2 Limits .......................................................................................................70
  4.3.3 Notes ........................................................................................................72
  4.3.4 Match Mark ...............................................................................................76

SECTION 5 PROJECT GENERAL SET ................................................................. 77
  5.1 Title Sheet ......................................................................................................77
  5.1.1 Creating a Project Title Sheet ..................................................................78
  5.1.2 Creating a Location Plan ..........................................................................81
  5.1.3 Creating Detailed Estimate Sheet ............................................................82
5.1.4 Creating a Subset Cover Sheet .................................................................................. 83

SECTION 6 DIMENSIONING ....................................................................................... 85

6.1 Right Of Way ............................................................................................................. 85
   6.1.1 ROW Hexagon ..................................................................................................... 85
   6.1.2 ROW Linear .......................................................................................................... 87

6.2 Lane Dimension ......................................................................................................... 87

6.3 Roadway Dimension .................................................................................................. 90
Thanks!

Thanks go out to all that contributed to the creation of this document, especially Samantha Scharpf who assisted with the writing and development; Nicolas Ivanoff, Stephen Hall and Sergey Nikulin for their help and review of class material; Salvatore Aresco for his review of the completed guide. The support and assistance that they provided has been invaluable and is greatly appreciated.

Gabriele Hallock
Introduction

This guide was developed for State Engineers and Consultant Engineers to serve as both a course manual and a reference guide for standard Connecticut Department of Transportation (CTDOT) CAD procedures. This manual should be used in conjunction with the CTDOT InRoads V8i Guide. Some new MicroStation tools have been added to the Tasks menu to simplify adherence to CTDOT standards.

For State Engineers these tools can be found in the existing CTDOT workspace.

For consultants these tools can be downloaded with the CTDOT Digital Design Environment (DDE), found on the following web page.

http://www.ct.gov/dot/cwp/view.asp?a=3194&q=483668&PM=1

The intent of this guide is to document standard digital design procedures currently in practice at the CTDOT and help the designer adhere to those standards. This document is not intended to prevent or limit individual creativities or engineering judgment used in project development and design.

The information provided in this guide is subject to change as technology and experience warrant, therefore, this guide will be updated as major revisions in design software and CTDOT DDE policies occur. Addendum to this guide will be available in digital format only.

Distribution

This manual, in its entirety, may be freely copied and distributed for the purpose of providing a consistent guide to MicroStation requirements of the CTDOT. The MicroStation V8i Guide for Highway Designers will be available soon on the AEC Applications website.

Trademarks

“MicroStation” and “InRoads” are registered trademarks of Bentley Systems, Incorporated. Other trade names, computer protocols, and file formats mentioned in this manual are the trademarks of their respective owners. In no event will the appearance of any graphic, description of a graphic, picture, screen display, or any other method of conveying meaning, be considered to impair the rights of the respective owners.

Additional Resources

As mentioned earlier, this manual is not intended to be a sole source of information for the CTDOT MicroStation user; there are various resources available to designers.
HELP Command: MicroStation software has extensive online help available through Help on the Menu Bar. Practice and experience using MicroStation is the key to becoming a proficient user.

Bentley Learning Website: CTDOT employees can access the Bentley Learning Web site at the following link http://www.bentley.com/en-US/Training/.

Phone Assistance: Users can call Bentley directly at:

1-800-778-4277 for SELECTservices (i.e. Bentley User ID) or

1-800-BENTLEY for all other calls.

To access these learning resources from Bentley Systems, Inc., CTDOT employees should contact (email) Samantha Scharpf of AEC Applications to have a Bentley User ID issued to them.

Note: Consultant Engineering firms must purchase their own training subscriptions directly through Bentley.

CTDOT AEC Applications has developed MicroStation preferences and Tasks in an effort to tailor Bentley Software to CTDOT user needs. If you have questions regarding this manual or the CTDOT MicroStation preferences, please contact:

Elaine Richard
AEC Applications
Elaine.Richard@ct.gov
(860)594-3278

Gabriele Hallock
AEC Applications
Gabriele.Hallock@ct.gov
(860)594-3244

Samantha Scharpf
AEC Applications
Samantha.Scharpf@ct.gov
(860)594-2902

Note: Consultant engineering firms can download the CTDOT SELECTseries Digital Design Environment from the CTDOT webpage at:

http://www.ct.gov/dot/cwp/view.asp?a=3194&q=483668&PM=1
Section 1  Getting Started

1.1 Opening MicroStation through Accounting

1. Double click on the Accounting icon located on your desktop.

2. Within the CT DOT Accounting Menu (Figure 1) select Run Program: (1), choose MS 8i Highways. Select the project number for your project from the Available Accounts (2) and then highlight it within the Frequently Used Accounts (3). Select the correct Resource Type (4) and click on Start (5) button.

Note: If your project is not in the Available Accounts, please contact Helpdesk.
1.2 Creating a User Interface & Configuration Files

1. For a first time MicroStation V8i user the “out of the box” MicroStation Manager Interface will appear, the CTDOT user must first create a User Interface and secondly a User Configuration File, see Figure 2.

2. Select the Interface (1) pull down, select New and type in your username.

   *It must match your computer login exactly and is case sensitive.*

   Click the OK button.

3. Select the User (2) pull down, select New and type in your user name (the same as entered above). This will create your user configuration file (.ucf). Click the OK button.

Figure 2 - User Interface & Configuration Files
4. In the Project drop down select one of your groups design projects. Browse to any *.dgn file, open the file and then immediately exit out of MicroStation. The next time you go into MicroStation you should see the CTDOT MicroStation Interface as shown in Figure 3. Ensure your User and Interface configurations are active and open your project file.

![MicroStation Interface Figure 3 - CTDOT MicroStation Interface](image_url)
1.3 Selecting a Project Configuration

Once you get into MicroStation through Accounting you will see the dialog box “File Open” for opening and/or creating new files in MicroStation (Figure 4).

![MicroStation File Open Dialog Box](Figure 4 - MicroStation File Open Dialog Box)

Next you will choose a project configuration by selecting the project number from the project pull down. The project configuration file exists to facilitate sharing of configurations among users in a workgroup as well as setting the locations and names of data files associated with a specific design project and directs to the project container on the X-drive.

The project configuration file is the file that is selected when you pick your project from the CTDOT MicroStation Interface, see Figure 3.

1. **Pick** the project number for your project (Figure 4); this will direct you into the project container (folder).
2. **Open** your Discipline folder (Highway).
3. From here continue to the section for your next task (file).
If the project you are working on does not appear in the project pull-down, your project does not have a project folder (container) on the X drive. To request a folder on the X-Drive send an email requesting a new project folder, include project number and a short project description (5 – 7 words) to:

John Rinaldi  
(John.Rinaldi@ct.gov)  

and  

Ron Tellier  
(Ronald.Tellier@ct.gov)

See Example below:

![Email Request Project Container]

Figure 5 - Email Request Project Container
1.4 Selecting the Correct Seed File

A seed file is *MicroStation*’s term of a template. When you select **File > New, MicroStation** makes a copy of the selected seed file, places it into your selected project container (folder) and **you** give it a new name, see Section 2 - *MicroStation* - Design Models and the file naming conventions in Appendix C of the [CTDOT_DDE_Guide](#), also find the guide and more within *MicroStation*, see Figure 6.

![Figure 6 - Find the CTDOT DDE Guide within MicroStation](image1)

The *MicroStation* seed files can be found in `W:\Workspace\Standards\seed` (Figure 7) and there are various seed file models depending on need:

![Figure 7 - Seed Files](image2)
MicroStation V8i Guide for Highway Designers

- **2D Design Models** - used to layout all geospatially located graphics, horizontal alignments for *InRoads*, use the seed file *CT_Design_2D_V8i.dgn*.

- **3D Design Models** - used to layout design features for *InRoads*, all 3-D graphics for the *InRoads* design model and design surface, use the seed file *CT_Design_3D_V8i.dgn*.

- **Geospatially located Sheet Files** use a border cell and will contain the annotation, use the seed file *CT_Sheet_Civil_2D_V8i.dgn*.

- **Detail Sheet Files** - typical sections and miscellaneous details that use a border cell, are not geospatially referenced and will contain drafting and annotation, use the seed file *CT_Sheet_Arch_2D_V8i.dgn*.

- **Project Title Sheet** – Each project has one title sheet, the project manager unit establishes the title sheet for the project. For Highway projects the Highway unit prepares the title sheet, use the seed file *CT_Title_Sheet.dgn*. 
1.5 MicroStation Design Model File Conventions

In Highway Design, MicroStation and InRoads are used to design a highway project and graphics are shown in 3D and 2D MicroStation design models depending on the purpose and need of the file.

**There is only one design model per dgn file;**

with only **one** exception → cross sections.

MicroStation design model files are in 3D or 2D format and are for **design purposes only**; there are **no** annotations, call outs and/or Construction notes in design models.

It is important that the appropriate levels are used because other units regularly reference highway design files into their design. Using the Highway Tasks (Drawing in the 2D Design Model) in MicroStation makes this easy; the tasks automatically use the correct levels and cells. No annotation other than stationing and ROW Hexagons and ROW dimensions (offsets) should be in the design model files.

1.5.1 Utilizing InRoads and MicroStation for 3D Design

The majority (95%) of Highway Design projects fall into this category. 3D design will be used on projects that have a 3D survey file with existing DTM and require a proposed surface or model. Projects types that are typically designed in 3D are; new construction, full depth reconstruction, and widening. InRoads is used to complete the design.

The designer needs to create **three (3) design model files** for the planimetric view (plan view) when utilizing InRoads and MicroStation for 3D design. See **Flow Chart 1 - File Creation for a Design Project**

The designer creates:

1. A **3D design model** to create 3D graphics. The designer should follow the CTDOT InRoads V8i Guide to complete the design in InRoads.

   All InRoads design work is first performed in this file except drainage, the usual workflow (milestones) for an InRoads design is:
InRoads Milestones:

When the design is completed, clean up the design model, remove features and alignments displayed in 2D (elevation 0.00) and move/redisplay to 2D design model. The design features displayed in the 3D model include:

- Design Surface (proposed DTM); all breaklines generated from the proposed design including top layer, sub-layers, and components.
- Subgrade DTM - displaying only sub-grade breaklines within the roadway limits.
- Breakline features such as: Edge of Road (EOR), channels, back of curbing and sidewalk.

**Note:** The designer will likely use a 3D design model as his/her “InRoads Scratch” file, an InRoads working file only intended for the designer and create a 3D design model file for other engineers and units to reference.

2. A **Drainage model.** The drainage model can be done in 3D using **InRoads Storm and Sanitary** or in 2D using **StormCAD** (standalone software).

The designer has to make the decision as to what drainage software to use depending on the projects constraints, both **Storm & Sanitary** and **StormCAD** are approved by the Department’s Hydraulics and Drainage Unit. It is up to the designer to make the final decision as to what software to use; AEC Applications has developed a flow chart to help in the selection of the drainage software. **Section 4.3 Contract Sheet Annotation**.
Table 1 - InRoads Storm and Sanitary vs. StormCAD show in Plan View gives an overview of constrains for both, also see Flow Chart 2 - Which Program to use for Drainage Design.

The designer should create a design model (scratch file) for the entire drainage design which includes drainage areas, flow paths, roughness coefficients, inlets, outlets and pipes. This file is only intended for the designer and not to be included in the contract plans. If using StormCAD V8i use the workflow: “StormCAD with MicroStation Start-up” which can be found on AEC Applications webpage for the drainage design.

Next the designer creates the design model file for the complete drainage design layout. The drainage design layout includes pipes, catch basins and culvert ends etc. Annotation for these features such as type and length of pipe, invert elevation is created/located in the plan sheet (see Section 4.3 Contract Sheet Annotation).

Table 1 - InRoads Storm and Sanitary vs. StormCAD show in Plan View

<table>
<thead>
<tr>
<th>InRoads Storm and Sanitary (3D design model)</th>
<th>StormCAD (2D design model)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pipes double line (inside diameter) at station, offset and invert elevations</td>
<td>Pipes double line (inside diameter) at station and offset</td>
</tr>
<tr>
<td>Culvert ends – 2D cells at station, offset and invert elevation</td>
<td>Culvert ends cells at station and offset</td>
</tr>
<tr>
<td>Endwalls, splashpads, scourholes – 2D shapes at station, offset and invert elevation</td>
<td>Endwalls, splashpads, scourholes – 2D shapes at station and offset</td>
</tr>
<tr>
<td>Catch basins - 2D cell at station, offset and top of grate elevation</td>
<td>Catch basins - 2D cell at station and offset</td>
</tr>
<tr>
<td>Paved apron – 2D shape at station, offset and grate elevation</td>
<td>Paved apron – 2D shape at station and offset</td>
</tr>
<tr>
<td>Manhole – 2D cell at station, offset and top of frame elevation</td>
<td>Manhole – 2D cell at station and offset</td>
</tr>
</tbody>
</table>

When the drainage design in StormCAD is complete, the designer has the option to import the StormCAD drainage design into InRoads Storm and Sanitary (to create a 3D design model) and have InRoads Storm and Sanitary place the drainage pipes and
structures in the plan, profile and cross sections, otherwise, the designer must draft the proposed drainage in the plan, profile and cross section views.

3. **A 2D design model.** The 2D model is used for laying out alignments in *InRoads* including:
   - **Horizontal alignments** such as baselines/centerlines, EOR and proposed ROW alignments
   - **Point control lines** from DTM (EOR, channels, back of curbing and sidewalk)
   - **Cut and Fill limits,** i.e. slope and grading limits. These are displayed with *InRoads* and modified by designer as needed.

Added by the designer using *MicroStation* (drafting):
   - Guiderail design and any Precast Concrete Barrier Curb
   - Patterning for milling, scarifying pavement, pavement removal, riprap channels and riprap slopes
   - Bituminous and concrete pavement saw cut line (line weight 6)
   - Bituminous and concrete saw cut at beginning & end of project and at limits of construction (line weight 10)
   - Erosion control systems and mitigation design
   - Driveway curb returns and ends
   - Utility MH’s, HH’s, gates, boxes and poles to be reset
   - Fences and retaining walls
   - ROW Easements and Acquisitions

### 1.5.1.1 Profile and Cross Sections for 3D Design

For design purposes only the designer can create 2D design models to display the profile and the cross sections. **For final design** the designer should follow the workflow established in the **CTDOT InRoads V8i Guide** on the [AEC applications webpage](#).

### 1.5.2 Utilizing *InRoads* and *MicroStation* for 2D Design

2D design will be used for projects that have 3D survey but a proposed surface is not required, maybe used for 5% off Highway Design projects. Project designs that are typically designed in 2D are roadside safety improvements, some overlays and resurfacing, i.e. projects without earth work. *InRoads* is used to complete the design features. The designer needs to create two (2) design model files for the planimetric view (plan view) when utilizing *InRoads* and *MicroStation*.

The designer creates:

A. **A 2D design model** for *InRoads* display of features and alignments. All design work is performed in this file. The designer should follow the workflows in the **CTDOT InRoads V8i Guide** to complete the *InRoads* design work. See **Flow Chart 1 - File Creation for a Design Project**
Design features placed using *InRoads*:

- Horizontal alignments for all roadway centerlines/baselines
- Horizontal alignments for all Proposed ROW and EOR alignments
- 2D placement of all design elements

Added by the designer with *MicroStation* (drafting):

- Guiderail design and any Precast Concrete Barrier Curb
- Patterning for milling, scarifying pavement, pavement removal, riprap channels and riprap slopes
- Bituminous and concrete pavement saw cut line (line weight 6)
- Bituminous and concrete saw cut at beginning/end of project and at limits of construction (line weight 10)
- Sedimentation control system and mitigation design
- Driveway curb returns and ends
- Utility MH’s, HH’s, gates, boxes and poles to be reset
- Fences and retaining walls

B. Drainage model, the drainage design can be done in *InRoads Storm and Sanitary* or *StormCAD*. If using *Storm and Sanitary* a 3D drainage model is used, see CTDOT InRoads V8i Guide found on [AEC Application Webpage](#). If using *StormCAD* follow the Workflow for “StormCAD with MicroStation Start-Up” also found on [AEC Application Webpage](#). See [Flow Chart 2 - Which Program to use for Drainage Design?](#)

### 1.5.3 Utilizing *MicroStation* and some *InRoads* for 2D Design

2D design will be used very rarely for design purposes limited to guiderail reset etc. 2D design with limited *InRoads* will be used for projects that only have 2D survey files and no DTM’s. Projects typically designed in 2D with limited *InRoads* include milling and overlay, overlay and roadside safety improvement projects. *InRoads* is not used for the creation of the design. No drainage software is used since no drainage design is needed.

The designer creates:

A 2D design model, all design work is performed in this file. The designer creates one (1) design model file for the planimetric view (plan view). *InRoads* is only used to establish horizontal alignments for all roadway centerlines/baselines and for proposed ROW. The designer uses *MicroStation* to place (draw) all design elements including drainage; see [Flow Chart 2 - Which Program to use for Drainage Design?](#)
Flow Chart 1 - File Creation for a Design Project

Project uses 2D Design (sec 1.5.1.2 & 1.5.1.3)

Create 2D Design Model (sec 2.1.1)

Project involves any of the following:
- New Roadway Construction
- Full Depth Reconstruction
- Widening
- And has a 3D Survey File with existing DTM & Existing Drainage

YES

Project uses 3D Design (sec 1.5.1.1)

Create 3D Design Model (sec 2.1)

Create 2D Design Model (sec 2.1.1)

95% of Highway Design Projects

InRoads Requirements

Project resources/reqs are:
- 2D Survey File w/ no existing DTM
- No drainage calculations required
- Project Type Examples:
  - Milling &/or overlay
  - Roadside Safety Improvements

InRoads is used for:
- Horizontal Alignments for Centerlines & Baselines
- Proposed ROW alignment

Create Drainage Files (See next flow chart)

Project resources/reqs are:
- 3D Survey File
- Project design does not require Proposed Surface
- Project Type Examples:
  - Roadside Safety Improvements
  - Pavement resurfacing

InRoads is used for:
- Horizontal Alignments for
  - Centerlines & Baselines
  - Proposed ROW & EOR
- 2D Placement of all Design Elements

Create Drainage Files (See next flow chart)
Flow Chart 2 - Which Program to use for Drainage Design?

- Relatively Straightforward Drainage System
- Minor Drainage improvement required
  - Use InRoads Storm & Sanitary
  - Create 3D MicroStation File for Drainage (sec 2.1)
  - Use InRoads Storm & Sanitary with your project InRoads file to design drainage system in MicroStation Drainage file
  - Project in 2D or 3D?
    - 2D
      - Reference Drainage MicroStation file into 2D Design Model
    - 3D
      - Reference Drainage MicroStation file into 3D & 2D design model. Use InRoads to draft drainage in cross sections & profiles

- Detailed or Complicated Drainage System:
  - New or Upgrade Drainage System
  - Major drainage improvement required (system currently has drainage problems)
  - Use StormCAD
    - Create 2D MicroStation File for Drainage (sec 2.1.1)
    - Create StormCAD file
    - Use StormCAD to design drainage system in MicroStation Drainage File
    - Project in 2D or 3D?
      - 2D
        - Reference Drainage MicroStation file into 2D Design model. Manually draft drainage system into cross sections & profiles
      - 3D
        - Drafting Method
          - Manual
            - Create 3D MicroStation file for drainage (sec 2.1)
          - Auto
            - Import StormCAD Data into InRoads Storm & Sanitary and follow flow chart for 3D Storm & Sanitary design

MicroStation V8i Guide for Highway Designers

Version 2.0
1.6 **MicroStation** Sheet File Conventions

**All sheet files are 2D.** There are two (2) sheet seed files available in the workspace folder (W:\Workspace\Standards\seed): CT_Sheet_Civil_2D_V8i.dgn and CT_Sheet_Arch_2D_V8i.dgn.

![Figure 8 - Sheet Models](image)

1.6.1 Geo-Referenced Cut Sheet

The **Geo-Referenced Cut Sheet** such as a plan sheet uses the CT_Sheet_Civil_2D_V8i.dgn seed file; the survey file(s) and the design file(s) are referenced geospatially correct, see Section 3 - Geo-Referenced Sheet Models.

- The **MicroStation** view will be rotated, not the reference files. Follow the workflow in this document, or from the **MicroStation** menu bar under CTDOT 2007 Utilities or on the web: [Creating a Geo-Referenced Cut Sheet](#).

- The file naming conventions as described in Appendix C of the [CTDOT_DDE_Guide](#) should be followed.

- Use the **MicroStation** Tasks for **CT DOT Sheet Composition**.

- Only one border cell is in each sheet model file (Plan Sheet)

- When **InRoads** is used for the design work, it is recommended the plan sheets and profile sheets are created using the **InRoads Plan and Profile Generator** (Figure 9), see [InRoads Plan Production in the CT DOT InRoads V8i Guide](#).

- **All annotations are in the sheet model file.** Examples include call outs for pay items, beginning and end of project, limits of construction and call outs for drainage structures and pipe types and sizes.
Figure 9 - InRoads Plan & Profile Generator

- General notes, ROW legend and construction notes for small projects are usually included on the first plan sheet. For larger projects a separate sheet may be required for the notes and legend; if needed, the seed file CT_Sheet_Arch_2D_V8i.dgn should be used.

1.6.2 Detail Sheet

A. **Typical Sections, Miscellaneous Details and Notes and Legends** use the CT_Sheet_Arch_2D_V8i.dgn seed file.
   - **NO** geospatially referenced files are attached.
   - Only one border cell is in each sheet model file.
   - The file naming conventions in Appendix C of the CTDOT_DDE_Guide should be followed.
   - Typical Sections and Miscellaneous Details should be drafted in the sheet model, a design model is not necessary.

B. **Detailed Estimate Sheet** uses the CT_Sheet_Arch_2D_V8i.dgn seed file.
   
   A. The file naming conventions in Appendix C of the CTDOT_DDE_Guide should be followed.

   B. **Only one border cell should be in each Detail Estimate Sheet file**, if more than one sheet is necessary, another file with another border is required.
1.7 Levels

All levels are named and have default colors, line weights, and line styles, providing the foundation for the many features and pay items used in the design of projects. An important benefit of the level system is the ability to standardize level structures across DGN files and disciplines.

AEC Applications established a standard level naming convention and has predefined levels for your discipline with the help from engineers in the Highway Design unit.

1.7.1 Standard Level Naming Convention

![Diagram of level naming convention]

Table 2 - Standard Level Naming Convention

<table>
<thead>
<tr>
<th>DISCIPLINE DESIGNATOR</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>H</td>
<td>HIGHWAYS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>OFFICE DESIGNATOR</th>
<th>DESCRIPTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>ROADWAY</td>
</tr>
<tr>
<td>D</td>
<td>DRAINAGE</td>
</tr>
<tr>
<td>C</td>
<td>CONSTRUCTION</td>
</tr>
<tr>
<td>M</td>
<td>MODELING</td>
</tr>
<tr>
<td>U</td>
<td>UTILITY</td>
</tr>
<tr>
<td>X</td>
<td>RAILROAD</td>
</tr>
<tr>
<td>T</td>
<td>TRAFFIC</td>
</tr>
<tr>
<td>S</td>
<td>STRUCTURES</td>
</tr>
<tr>
<td>P</td>
<td>PROPERTY – ROW</td>
</tr>
<tr>
<td>B</td>
<td>SHEET ANNOTATION</td>
</tr>
</tbody>
</table>
1.7.2 Non-Standard Level

Should the designer have the need for a level not in the standard list, a new level can be created.
The designer should use standard level naming conventions to create the new level. This should
not be done precariously and only when absolutely necessary. If you notice a level doesn’t
exist, but needs to be created more often, contact AEC Applications to include this level with the
standard list.
**Section 2** MicroStation - Design Models

Each MicroStation DGN file can contain one or multiple Models. These Models can be 3D or 2D.

**The CTDOT standard is one Design Model per DGN file.**

### 2.1 Creation of a 3D Design Model

Create a 3D design model used for InRoads to generate the design surface models or for drainage design. See Section 1.5 for clarification on file types.

1. Once you have gone through Accounting and have chosen your project configuration, your project container, browse to the folder inside your project where you want your design file to reside. Example: 1234_1234/Highways/MSta_Design/.

2. Click on **New File** icon

3. In the **New File** box. At the bottom right, next to the file path for the seed file, click on **Browse** (see Figure 10).

![Image](image.png)

*Figure 10 – In Directory where file is to reside*
4. Select the correct seed file (Figure 11), browse to:

\W:\Workspace\Standards\seed\CT_Design_3D_V8i.dgn and click Open.

![Figure 11 - Select Design Seed File](image)

5. Use the file naming conventions in Appendix C of the CTDOT_DDE_Guide and this guide; type in the file name as outlined in the Highway Design CAD File naming convention, example: HW_MST_1234_1234_3DLayout_MDL.dgn

Click Save.

6. In the File Open box, select the file you just created and click Open, see Figure 12.

![Figure 12 - Open Design Model MicroStation File](image)
7. When the file is open, click on **Workspace** (1) > **Preferences** (2); Figure 13. In the preferences box select **Reference** (3) and make sure ‘**Use Color Table**’ (4) is toggled on. Click **OK**. (Necessary first time into MicroStation and when new User Preference file)

![Figure 13 - Workspace Preferences](image)

8. Back in the **MicroStation** view, **click** on the **References** icon (Figure 14) to open the References dialog box.

![Figure 14 - References Icon](image)

9. On the References dialog box click **Attach Reference** icon (Figure 15).

![Figure 15 - Attach Reference Icon](image)

10. Navigate to the Survey folder and reference in the survey file. **Click Open.**

   **Example:** `SV_D1_1234_5678_STREET_RT_12_GROUND.dgn`. 
You should have received an email/memorandum from Central Survey notifying you of the location and file name of the survey files, usually in response to a survey request submitted previously.

11. Select 3D Design as Model, type in SURVEY for Logical name, No Nesting for Nested Attachments and Click OK. See Figure 16.

![Figure 16 - Reference File Attachment](image)

12. Fit View Close the references dialog box.
13. Select **Level Display** and turn off desired levels in the reference file and **close** the Level Display box (Figure 17).

![Figure 17 - Level Display Box](image)

14. In MicroStation select **File > Save Settings**. This saves the file with the levels off, this helps when you open the file the next time.

15. The file is now ready for design work. The designer can now start up **InRoads** and follow the workflows within the **CTDOT InRoads V8i Guide**.
2.2 Creation of a 2D Design Model

Create a 2D design model used for **InRoads** to generate the horizontal alignments, drainage design and/or drafting.

1. Use the correct folder inside your project where you want your design file to be located, example: 1234_1234/Highways/MSta_Design/.

2. Click on **New File** icon.

3. Click on **Browse**, on the bottom right, next to the file path for the seed file, see Figure 18.

4. Select the correct seed file, browse to: 
   W:\Workspace\Standards\seed\CT_Design_2D_V8i.dgn and click **Open**.

5. Use the file naming conventions in Appendix C of the **CTDOT_DDE_Guide**.

   Type in the file name as outlined in the Highway Design CAD File naming convention, example:

   **HW_MST_1234_1234_2DLayout_MDL.dgn** if you are doing design or 
   **HW_MST_1234_1234_Drainage_MDL.dgn** if you are doing drainage design.

   Click **Save**.

6. In the File Open box, select the file you just created and click **Open**.

7. When the file is open, click on **Workspace > Preferences**, select **Reference** and make sure **Use Color Table** is toggled on, see Figure 13 - Workspace Preferences. Click **OK**.
8. Next click on the References button to open the References dialog box.

9. Reference in the files needed. The survey file (SURVEY), your design file (InRoads model). Select 3D Design as Model, NO Nesting for Nested Attachments and Click OK.

10. Close the references dialog box. In MicroStation view click Fit View.

11. Select Level Display and turn off levels in the reference file(s) as needed. Close the Level Display box, Figure 17.

12. Select File > Save Settings. The file is saved with the levels off, this helps when you open the file the next time.

13. The file is now ready for design work. The designer can now start up InRoads and follow the workflows within the CTDOT InRoads V8i Guide for Horizontal Alignments or do design work (drafting) in this file.
2.3 Drawing in the 2D Design Model

The designer should not be drawing anything in the 3D InRoads Design Surface Model. When InRoads is used only elements from the proposed design surface (DTM) created using Roadway Designer will reside within the 3D design model, see MicroStation Design Model File Conventions.

AEC Applications has created tasks to simplify drafting; they are grouped by discipline/area.

A task is a set of tools grouped to facilitate a particular job/task. Tasks comprise a command with the correct symbology for a feature and/or pay item.

If you don’t see the Main Task menu click on ‘Tools’ and toggle on ‘Tasks’ (Figure 19), usually it pops back to the left side of your MicroStation view. You can dock it where you want it.

Figure 19 - Main Task Menu
Click on the **Highway** Task bar (Figure 20) within the Main Task bar, Highway Tasks for various Highway categories opens. **Click on Roadway.**
2.3.1 Roadway Tasks

There are many roadway tasks available, only a few are shown below. You can explore all in more depth by yourself. As an example to use the CUT line, follow the cut lines from your InRoads design surface model that you referenced into your 2D MicroStation design model and adjust as needed.

![Example Roadway Tasks](image)

**Figure 21 - Example Roadway Tasks**

1. To invoke the CUT task, **Click** on ‘CUT’ (Figure 21). The **Place Smartline** command (Figure 22) will be activated with the **CUT** symbology.

![Command Activated](image)

**Figure 22 - Command Activated**

2. Make sure **Join Elements** is toggled **on**. This will create a line string (one element).
3. Follow the cut feature line from your InRoads design surface model, adjust as needed.
2.3.2 Safety & Fences Tasks

The engineer uses the CT-DOT Highway Design Manual and AASHTO Roadside Design Guide to design the guide rail needed and uses the tasks to place the guide rail (Figure 23). Fences are placed by the designer where needed invoking the various fence tasks (Figure 24).

A. Safety tasks consist of the Place SmartLine commands or the Place Active Cell commands. Shown below are a few of the tasks (Figure 23).

![Figure 23 - Safety Tasks]

B. Fences tasks consist of Place SmartLine commands.

![Figure 24 - Fence Tasks]

2.3.3 Rights Of Way (ROW) Tasks

The Rights Of Way tasks are used to show the limits of properties (private, municipal or State), limits of rights and ROW hexagon for ROW legend. See Section 6.1 – Dimensioning – ROW for tasks showing the dimensioning of rights or property lines.

1. Click on the ROW task for the line you want to draw; the Place SmartLine command will be activated. Draw the ROW lines following the Departments Policies and Procedures for
Property Maps’ guide as to where and how to place ROW lines. The various Row lines and the ROW hexagon commands are shown in Figure 25:

![Figure 25 - ROW tasks](image)

Refer to Section 6.1 for placement of the ROW Hexagon and ROW dimensions.

2.3.4 Construction Staging

These lines (tasks) are showing the Temporary Precast Concrete Barrier Curb (TPCBC) used as temporary barrier during stage construction (Figure 26). Each color shows a different stage of placing, removing, relocating or resetting TPCBC. Not to be used for proposed Precast Concrete Barrier Curb.

![Figure 26 - Construction Staging Tasks](image)
2.4 **InRoads** Storm & Sanitary

2.4.1 Plan View

*Storm and Sanitary* places most drainage structures and pipes with the appropriate cells, line styles and levels; the exceptions are culvert ends. The designer has to place culvert ends into the 3D drainage design model using the Storm & Sanitary Culvert Ends task, see Figure 27.

![Image of Storm and Sanitary Culvert Ends task]

**Figure 27 - Storm & Sanitary CE Task**

1. Click on the Storm and Sanitary Culvert Ends task. This will open the Cell Library.
2. In the library all cell names start with **SS** for **Storm & Sanitary**, see Figure 28.

![Image of Storm and Sanitary Culvert End Cells]

**Figure 28 - Storm and Sanitary Culvert End Cells**
3. **Click** on the Culvert End needed in the cell library. Then click on Terminator. This will make that cell active. *(SS_MCE 18 in..pl)*

4. Now activate the **Place Active Line Terminator** command.

5. Select the **end of pipe line** and click again to place the culvert end. **Trim** back the pipe the match culvert end. (See Figure 29).

![Image of MicroStation V8i Guide for Highway Designers](image)

**Figure 29 - Place Storm & Sanitary Culvert Ends**

Next the designer needs to reference the 3D drainage model into the 2D design model.
1. Open the 2D design model and click on the References button to open the References dialog box. On the References dialog box click Attach Reference.

2. Navigate to the Highway folder and reference in the Storm & Sanitary drainage file (3D design model file). Select 3D Design as Model, type in Drainage for Logical name, No Nesting for Nested Attachments and Click OK. Close the references dialog box. Fit View.

Drainage items for riprap, scour pads need to be placed manually by the designer in the 2D design model. See Drainage Plan Tasks in the StormCAD section (Section 2.5).

2.4.2 Profile

The InRoads Storm and Sanitary workflow (see CTDOT InRoads V8i Guide) should be used to place drainage pipes and structures in profile view (generated using InRoads Plan and Profile Generator). This will place pipes, catch basins and manholes not just at the correct locations and elevations, but also with the correct levels and line styles. The designer still has to place the culvert ends using the appropriate Drainage Profile Tasks, see Figure 30.

Figure 30 - Storm & Sanitary Culvert End Placement - Profile
1. Select the Drainage Profile Task menu.
2. Select the Culvert End task needed from the pull-down menu. (This activates the Place Active Terminator command)
3. Click at the end of pipe where culvert end is to be placed and accept the location.
4. Trim back the pipe as needed.

2.4.3 Cross Sections

The InRoads Storm and Sanitary workflow (see CTDOT InRoads V8i Guide) should be used to place drainage pipes and structures in cross sections generated using InRoads. This will place pipes, catch basins and manholes not just at the correct locations and elevations, but also with the correct levels and line styles. The designer still has to place the culvert ends using the appropriate Drainage Cross Section Task and follow the MicroStation command prompts, see Figure 31.

![Figure 31 - Storm & sanitary Culvert End Placement - Cross Section](image)

1. Select the Drainage XSC (cross section) task menu.
2. Select the Culvert End task needed from the pull-down menu. (This activates the Place Active Terminator command)
3. Click at the end of pipe where culvert end is to be placed and accept location.
4. Trim back pipe as needed.
2.5 Drafting Drainage when using StormCAD

2.5.1 Plan View

The StormCAD drainage design model is really just a schematic and the designer has the option to import into Storm & Sanitary to be converted to 3D graphics; or if the designer chooses not to, he/she must draft the drainage into the 2D MicroStation design model.

2.5.1.1 Drainage Plan Tasks

The Drainage Plan tasks (Figure 32) entail various commands, see list below:

- Place SmartLine
- Place Active Cell
- Place Shape
- Pattern Area

Each command places lines, cells, shapes or patterns areas with the correct levels and line styles. Below are the various drainage plan tasks.

Example:

1. Click on the task to place a TYPE “C” CB, this invokes the Place Active Cell command.
2. Select Interactive and Rotate Only. Data point to where the catch basin is to be located.
3. Rotate the basin to align with the edge of roadway, accept the location. Reset to end command.
4. Repeat with other catch basin cells and drainage structures. See Figure 33 - Type "C" CB task.
2.5.1.2 Pipes and Ends

After the catch basins and other structures are placed the designer will place the culverts and culvert ends (pipes and ends).

1. Select the Pipes and Ends task and expand the task menu.
2. Select the pipe material; reinforced concrete, corrugated metal or plastic. Also available are miscellaneous and temporary pipes as well as underdrains.
3. Each material has various sizes of piping, select the pipe diameter needed.
4. The Place Smart line command with the correct level symbology for the pipe diameter becomes active.
5. Place a line between drainage structures according to StormCAD design.
6. Continue to place pipes as needed.
7. Select the culvert end task; RCCE or MCE or PLASCE.
8. This invokes the Place Active Line Terminator. Data point to the end of the pipe and accept.
9. Trim the pipe as needed.

See Figure 34 - Tasks for Pipes & Ends.
2.5.2 Drainage Profile

If the designer used Storm CAD, he/she has to draw the drainage into the profile (created using InRoads Plan & Profile Generator) using the various Drainage Profile tasks (Figure 35); look for profile filename: HW_MST_Profile_2D_MDL.dgn. The tasks include placing cells for catch basins, manholes and culvert ends, placing text with and without leaders, drawing pipes using smart line commands.

Figure 35 - Drainage Profile Tasks

Drainage is drawn in the profile created by the profile generator. Text with and without leader is placed in the profile cut sheets, again generated by the InRoads Plan & Profile Generator.
2.5.3 Drainage Cross Sections (XSC)

The designer draws the drainage into the cross sections created with InRoads using the various Drainage Cross Section (XSC) tasks (Figure 36). The tasks include placing cells for catch basins, manholes and culvert ends, placing text with and without leaders, drawing pipes using SmartLine.

Figure 36 - Drainage Cross Section Tasks
Section 3  Geo-Referenced Sheet Models

CTDOT has standardized all cut sheets: plan sheets, profile sheets, cross section sheets and detail sheets are all in 2D.

3.1 Create Sheet Model & Attach Reference

It is recommended that the designer use InRoads – Plan and Profile Generator to create plan and profile cut sheets, the CTDOT InRoads V8i Guide should be followed. The designer can create plan border sheets using MicroStation and use Plan and Profile Generator just for Profile cut sheet generation.

3.1.1 Create Sheet Model

1. To create a geo-referenced plan sheet, click the “New” icon (new file) on the MicroStation menu bar and the New file dialog box will open. Ensure you are in the correct folder in the project container directory (see below):
   CTDOT_projects\XXXX_YYYY_2007\Highways\MSta_Contract_Sheet_Files\Plan.

   ![New File](image)

   If you are not in the right project container Close MicroStation and the File Open box appears, Pick your project container from the interface pull-down.

2. In the New File dialog box, click on the Browse button and select the seed file:
   CT_Sheet_Civil_2D_V8i.dgn. Click Open.
   (W:\Workspace\Standards\seed\CT_Sheet_Civil_2D_V8i.dgn).

3. Back in the New File dialog box, enter the File name; refer to the CTDOT DDE Guide for file naming convention (example: HW_MSH_XXXX_YYYY_PLN-00.dgn). Click Save.

MicroStation is creating the plan sheet model and opens it.

3.1.2 Attach Reference File

A reference file attachment is a model or MicroStation file (*.dgn) attached to and displayed within the active model (sheet or design). In a reference file levels can be turned on or off.
1. In the created plan sheet model, click on the References icon, in references dialog box click on the Attach Reference icon to attach the survey and design files.

2. Browse to the ‘Survey’ and/or ‘Highway’ folders, highlight the file(s) and click Open. The Reference Attachment Settings dialog box opens (Figure 37).

3. Type in logical names such as design, 2D design or drainage, depending on the file(s) you are attaching. For Plan Sheets use screening, such as the survey file type in SWW = SWW for Screen With Weights.
Screen With Weights; the weights of the line styles within that file will be maintained, but color will be gray. If you want to screen multiple files, type in SWW1 – SWW 2 and so on. Select Coincident, Scale 1:1, No Nesting, and True Scale OFF. Click OK. See Figure 37.

4. In your MicroStation view window click on Fit View. All your files, active and reference files, are geospatially correct attached.

5. **Double-check** (Figure 38), zoom to a coordinate grid cross and snap to it, the XY-axis in the MicroStation command window should display the same numbers as the northing and easting of the coordinate grid cross.

6. If something is incorrect (see Figure 39), check the Scale of your reference file(s), it should be 1:1. If it is not, select the reference file(s) and change the scale to 1 to 1. Update view.

![Figure 38 - XY and Northing Easting](image)

![Figure 39 - Reference File Scale](image)
Repeat Step 5 to check the grid coordinates of the reference file with the XY-axis in MicroStation.

7. Open Level Display.

![Level Display](image)

**Figure 40 - Level Display**

The Level Display box (Figure 40) will show you the active and inactive levels for the selected view (active view window); select the **All Used Levels** display filter. In each reference file **click on** the levels you want to **turn off**. You can also **right click** and use **Off By Level** and pick the lines / points of a particular level to turn off the level in the view window. You can turn off the levels in just one view or in all open views.

8. Click **File** on the **MicroStation** menu bar; click **Save Settings** to save all the settings you changed, such as all the levels you turned off in the reference files and in what view.

Note: Before you clip the reference file(s) a border needs to be placed see Section 3.2.1.

3.1.3 Update Sequence in Reference File

Update Sequence is the display order in which reference files are updated in the view windows, also the order they are printed or displayed in pdf-format. So if a file is listed at the top of the sequence that means it is loaded/displayed first and will appear on the bottom as if it is below the other files. The designer can manipulate how the plan looks by adjusting the update sequence. For example, if you see the call outs below the design and/or survey items on (above)
the design items, check your reference file update sequence, see Figure 41. This becomes very apparent for presentation plans.

1. **Click** on the reference file icon. Select **Settings → Update Sequence**.

2. Using the Update Sequence Tools (Figure 42) move the files either up or down to the desired location(s). The Active Design File should be the last file in the update sequence,
meaning this is the last layer the printer prints, see Figure 43. Sequence order for Highway Plan sheets: Survey, Design, Active File.

Note: This is especially important when preparing color presentation plans.

---

Figure 43 - Update Sequence Graphic

3. Click **OK**. In view window, click on **Update View**.

4. To save the changes of the changed update sequence to the active model, select **File > Save Settings.**
3.2 Place Plan Border and Transient Shape

The plan border cell and transient shape (sheet boundary) are used to define the layout of the paper for plotting a sheet model and are set to fit onto standard paper sizes (print/pdf sizes).

*The 2007 workspace uses a plan sheet size of 22” x 34” (ANSI D), this is the actual paper size.*

3.2.1 Plan Border Cell Placement

1. **Click** on **CT DOT Sheet Composition** within the Main Task menu, see Figure 44.

![Figure 44 - CT DOT Sheet Composition Tasks](image)

2. **Next click** on the **Common Borders** task bar.

3. **Select/Click** on the **Plan Border** task ⇒ the **Place Active Cell** command with the **Active Cell: BDR_Plan** is activated (Figure 45). Place the plan border cell in your plan sheet model where you want it. Follow the command prompts, bottom left in *MicroStation* view.

![Figure 45 - Place Plan Border](image)
4. If you need to move the border cells, turn off the level lock for the level: **CT_Locked** (Figure 46). This will allow you to move/rotate the border to the location/position you want. *Remember to lock the level again.*

![Figure 46 - Locked Level](image)

5. Tentative and data point to the left bottom corner of the border cell (1), this is also the cell origin. **MicroStation** command prompt: Define X axis of view (2), Tentative and data point to the right bottom corner of the border cell (3). View window will rotate and Display is complete (4). (Figure 47).

![Figure 47 - Rotate View Steps](image)
6. Before you clip your reference files, **copy** the **North Arrow** from the Survey Ground file (Figure 48) into your sheet model (this is the **only** item/cell you will copy from the survey file). Scale as needed for the scale of your plan sheet (20, 30 or 80 scale).

![Copy North Arrow](image)

**Figure 48 - Copy North Arrow**

7. If you are unable to fit the entire design within one border, additional plan sheet file(s) need to be created. Place match mark lines at full stations (Figure 49) where the sheets will be split. Match mark lines are perpendicular to the baseline/centerline. For further information see Section 4.3.4.

![Match Mark at Full-Station](image)

**Figure 49 - Match Mark at Full-Station**
8. Select the **Create Clipping Boundary Shape task**; this activates the **Place Shape** command. Place a shape around the reference elements you want within your clipping boundary, see Figure 50.

![Figure 50 - Clipping Boundary Shape Task](image)

9. In the references dialog box select all of the reference files you want to clip. **Right-click**, select **Clip Boundary** or select **Tools** from the References box and select **Clip Boundary**. Select the Method: **Element** (Figure 51). **Data point** on the shape (clipping boundary shape). **Accept and Reset**. See Figure 50 and look at the AFTER CLIPPING Figure.

![Figure 51 - Set Reference Clip Boundary Task](image)

10. **Fit View**. **Save Settings**.
3.2.2 Placing Transient Shape

A “Sheet Boundary Shape” has been created, which represents the outer most edges of the plan border. This “shadowed” shape is called a MicroStation transient element (shape). The transient shape does not print, however it is snap-able. When plotting and printing, MicroStation recognizes the transient shape so you do not have to place a fence when plotting.

1. Click on the Models Icon.

2. In the Models dialog box Right-click on the CT_Civil_2D_Sheet and select Properties. Toggle on Display Sheet Boundary. Click OK. (Figure 52)

![Figure 52 - Display Sheet Boundary (Model Properties box)](image)

3. In the Models dialog box click the Define Sheet Boundary icon.

Version 2.0
4. In **MicroStation** window click on **Fit view** to locate the transient shape (cut sheet border definition shape).

5. On the Sheet boundary dialog box (Figure 53) click **Move**, click over the transient shape and move it to the desired location. **Click** to place it at the new location, **right-click** to release the move command. If you need to rotate the transient shape, click **Rotate** on the Sheet Boundary dialog box, follow the **MicroStation** command prompts (right bottom) to rotate the transient shape.

![Figure 53 - Placing Transient Shape (Sheet Boundary)](image)

6. **Fit View** and **Save Settings**.
3.3 Border Title Block Information

The plan sheet’s title block needs to be completed and the correct designation level turned on. The border title block has “Tags” (data field set) attached to ease the labeling of the plan sheet.

1. From the main tool box select Tags ➔ Edit Tags. (Figure 54)

   ![Figure 54 - Edit Tags]

2. Data Point on any one of the dashes (Figure 55) within the title block. If dashes are not visible, click on the View Attributes icon in the view window and click ON the Tags.

   ![Figure 55 - Tag Marks in Plan Border Title Block]

3. The Edit Tags [Border_Titleblock_Text] dialog box opens (Figure 56). Type in the information for Project Number, Project Title (up to 3 lines), Town Names (up to 2 lines), Drawing Title (up to 2 lines), Drawing Number, Designer/Drafter and Checked by. Should the box not open the level could be locked, unlock level.

4. If there are fields you are not using toggle off by unchecking in the display column.

5. Click OK. (See Figure 56).
6. **Click on Level Display**. **Turn Off** the levels for the notes (Designation Level) not needed above the title block (Figure 55), such as New Sheet by Addendum, Semi-final Design Review etc. Also turn-off the levels for the scales not needed.

![Figure 56 - Edit Tags](image)

![Figure 57 - Level Display Box](image)

7. **Fit View** and **Save Settings**.
3.4 Creating Saved View

*MicroStation* has eight (8) view windows available to the designer. Each window can have different levels turned on and off. Saved views can be used for level and reference managing, and it can save time. It is a user’s preference to use or not. All eight (8) views can be turned on or off by clicking on the View Toggle for each view (Figure 58).

![Figure 58 - View Toggle](image)

1. **Click** on View Attributes in the open view window that you want to save (on top or bottom of view window).

2. Within the View Attributes box **expand View Setup** and **click** on Open Saved Views Dialog, the Saved Views dialog box opens (Figure 59).

![Figure 59 - Saved View Set-up](image)
3. Click on the Create Saved View icon (Figure 59). Label and toggle as shown below, Name: Print (as example). See Figure 60.

![Create Saved View](image)

**Figure 60 - Create Saved View**

4. Follow the MicroStation Command Prompt and data-point in the view window you want to save.

5. The Saved Views dialog will populate, there are various tools available to manipulate the saved views, and it’s up to the user to familiarize themselves with these tools.
Section 4  Detail Sheet Models

A detail sheet, also called arch sheet, is used for various sheet options such as: miscellaneous details, typical sections, boring logs, detail estimates. Since nothing is geospatially linked or referenced it is not necessary to place the plan border sheet geospatially.

4.1 Creating a Detail Sheet Model

The sheet model displays the transient shape and the plan border cell attached at XY = 0,0. It is used for details. See Figure 61.

1. In *MicroStation* click on the **New** icon. In the New dialog box click on **Browse** to select the seed file: *W:\Workspace\Standards\seed\CT_Sheet_Arch_2D_V8.dgn*; click **Open**.

2. For **File name**: Type in the name using the Highway Design CAD File Naming convention from the [CTDOT DDE Guide](#). For example; the name for a Typical Section sheet model would have the format: *HW_MSH_1234_1234_TYP-01.dgn*. After typing in the name click **Save**.

3. **Fit View**

4. **Fill** in the border title block as before and **turn off the levels** in the title block as needed. Select **File** and **Save Settings**.

5. The sheet model is now ready for drafting using *MicroStation* commands and tasks.

6. For annotation see Section 4.3 - Contract Sheet Annotation.
4.2 Using *InRoads* Templates as Typical Section

*InRoads* templates can be placed graphically but be aware snow shelf and cut & fill slopes do not graphically transfer.

1. If *InRoads* is not open. Within *MicroStation* click on Applications → InRoads Group → Activate InRoads. Select File → Open. Browse to the InRoads folder of your project and load the template library and the preference file.

Example: *Completed_HW_typicals.itl* and *CT_civil.XIN* both are in the student folder in the InRoads directory. It is important the preference file is also loaded for the correct symbology.

2. From the *InRoads* menu, open the *InRoads* Project Template Library. Click on Modeler → Create Template. Right-Click on the template to be displayed as Typical Section.

3. Click on Display..., see Figure 63. The Display Template dialog box opens.

---

**Figure 62 - Opening InRoads**

**Figure 63 - InRoads Template Library**
4. **Select** the vertical exaggeration you want, **Toggle OFF** Symbology, in the define End Conditions box select the Cut and Fill Slopes to be shown as typical, click **Apply**. See Figure 64.

![Figure 64 - Display Template](image)

5. In the **MicroStation** window select the location to place the template. Scale to the size needed. **Close** the Display Template dialog box or place another template.

6. **Finish** by drawing the existing ground, snow shelves and fill/cut slopes and add dimensions and notes as needed, see Figure 65. Make sure you use the correct symbology for the items. For annotation see Section 4.3 Contract Sheet Annotation.
Figure 65 - Typical Section using InRoads Template
4.3 Contract Sheet Annotation

All annotation such as: call outs, labels, notes and dimensions are placed in the sheet models. It is important that the correct tasks and levels are used.

1. Click on CT DOT Sheet Composition.
2. Click on the Contract Sheet Annotation task group (Figure 66).

![Figure 66 - Contract Sheet annotation Task Group](image)
4.3.1 Call Outs

There are three (3) different types of call outs for cut sheets, they cover Pay Item General & Pay Item Drainage, Non-Pay Item & Paid by Others & ROW Call Out and See Drawing XXX-## Call Out. Each call out is used specific to its name and has a task associated with it, see Figure 67.

![Figure 67 - Call Outs](image)

4.3.1.1 Pay Item General and Pay Item Drainage

The Pay Item General task is used for all call outs which have a pay item associated with it and is not a drainage item, such as Bituminous Concrete Park Curbing, Approximate Slope Limits, Sedimentation Control System, Scarifying Pavement etc., and each call out points to a particular pay item.

1. Click on Pay Item General. The Place Note box and the Text Editor will open in MicroStation.

2. Make sure the ‘Place Note’ is active (not ‘Place Call Out’) and that ‘Start At’: is set to Terminator (Figure 68).

3. In the Text Editor type in the required text for your pay item, example: 22’ – CUT BIT. PAVEMENT, and place the note by first placing the terminator pointing to the bituminous cut line and ending by placing the note at a location for the text on the cut sheet.

4. Continue to place call-outs as needed. 300 ′ - MBR RB-350, End Anchor Type 1, 50’ BCLC.
The call out – **Pay Item Drainage** – is for all drainage pay items such as catch basin, pipes, even call outs to see structure sheets for large culverts. Place same as Pay Item General.
Note: To associate the note with the item on the cut sheet, turn on Association Lock (Figure 69) and then toggle on Association on the Place Note command. With association turned on, the notes can be moved and the terminator will stay/remain at the pay item where it was originally placed. This helps when it becomes necessary to relocate a call out. (Exception: See Drawing No.)

4.3.1.2 Non-Pay Item, Paid By Others and ROW Call Out

The Non-Pay Item, Paid By Others and ROW Call Out do not have a particular pay item associated with them, but are used to direct the contractor to the particular use, disposition or location of those items. The style/look of these call outs are differentiated for better visibility and are placed in the same manner as Pay Item General.

1. Non-Pay Item is for items that remain in place, or become the property of the contractor, or to be saved and no associated cost/pay is incurred.
2. *Paid By Others* is usually for utility items, such as poles to be removed, replaced or placed by the utility companies. Any work that is not performed by the project contractor will be called out with this item.

![Figure 71 - Paid By Others](image1)

3. *ROW Call Out* is for ROW items such as but not limited to Taking Line, Construction Line and Drainage Right of Way (D.R.O.W.). Also see the “*Policies and Procedures for Property Maps*”.

![Figure 72 - ROW Call Out](image2)
4.3.1.3 See Drawing XX-## Callout

This task places a call-out with a link to a drawing in the plan set. See Project Explorer & Managing Drawing No. work flow to link drawings to the call-out, also to link drawing numbers to match marks.

4.3.2 Limits

Limits (Figure 73) define the beginning and end of projects and the limits of construction on roadways as well as the pay limits for the project. It is important that all limits are shown and called out in the project plan sheets.

Figure 73 - Limits Tasks

1. **Click on** the Begin / End Project Limits task to place the limits note. The Place Note and Text Editor boxes will open in MicroStation as before, but with different dimension style and symbology.

2. Make sure the ‘Place Note’ option is **active** and that **Start At:** is set to **Terminator**.

3. **Turn on** Association Lock and then **toggle on** association on the Place Note command.
4. Place the note for Begin/End Project Limits and include project number, stationing and Northing/Easting (see Figure 74).

5. Place the note for Limits of Construction and include the stationing and Northing/Easting.

Figure 74 - Project Limits
4.3.3 Notes

Notes (Figure 75) are used to convey construction, right of way and construction sequence notes to the contractor and others. These notes are usually found on the first plan sheet or as an individual sheet if needed. Notes are also used for Legends on Typical Section Sheets, Notes on Detail Sheets and for Row Legends.

![Figure 75 – Notes](image)

1. Click on the **General Note Title** task, to activate the Place Text command and the Text Editor.

2. In the editor **type in** the text you want, example: “GENERAL NOTES:”. If you want to underline the title, you can toggle on “U” in the editor.

![Figure 76 - General Note Title Task](image)

3. **Place the General Note Title** where you want it. General Notes are usually placed at the upper left or right corner of the plan border, see Figure 77.

![Figure 77 - General Notes Title](image)
4. Next click on the **General Notes** task, this again activates the Place Text command and the Text Editor.

5. Type in the text you want in the editor and place the note where you want it (Figure 78).

![GENERAL NOTES:]

1. SEE GEOMETRY SHEETS FOR ALIGNMENT DATA.
2. SCARIFY PAVEMENT WHERE INDICATED ON PLAN ACCORDING TO SPECIAL PROVISION.
3. SEE BORING & TEST PIT SHEET FOR SOIL AND UTILITY DATA.
4. SEE MITIGATION PLAN FOR CULVERT INLET AND OUTLET PROTECTION.

**Figure 78 - Completed General Note**

**Note to Designer:**

If large/long notes need to be placed, you can type those in Microsoft Word or Notepad and paste them into your MicroStation file.

Below is an example using Microsoft Word and MicroStation tools.

1. **Type** your note in **Word**. **Select the text** you want and click ‘**Copy**’.

![Figure 79 - Microsoft Word Document]

2. In **MicroStation** click on the **General Notes task**. This will set your level, text style and symbology. See Figure 80.

**Figure 80 - MicroStation General Notes Task**
3. In the **Text Editor** (Word Processor) tool box **Right-Click** and **Paste**. The text from Microsoft Word will be copied into the MicroStation tool box. **Edit** the text as needed for your plan sheet. **Close** the Editor toolbox.

**OR**

1. **Type** your text in **Word** and **select** and **copy**, as before.

2. In **MicroStation** click on the **General Notes task**, to set level, text style and symbology. **Close** Text Editor.
3. From the **Edit Menu**, select **Paste Special**. In the Paste Special tool box select **Text To Design File**, click **Paste** (Figure 82).

![Figure 82 - Copy Microsoft Word into MicroStation](image)

4. **Place the text** where you want to place it. The text can now be edited in **MicroStation** using the Edit Text command. As you can see below the text symbology changed from the Word font (Arial, Figure 81) to **MicroStation** font (Verdana, Figure 83) and the other **MicroStation** text attributes.

![Figure 83 - Paste Text Into MicroStation](image)
4.3.4 Match Mark

When more than one plan sheet is needed, a Match Mark with Match Mark Text is needed to direct the viewer to the next sheet. A match mark depicts the Station where the plan was cut/sliced to create a new sheet and this is where the sheets match up.

![Match Mark Tasks](image1.png)

**Figure 84 - Match Mark Tasks**

1. **Invoke** the Match Mark Line task. The correct symbology is set and the **Place Smart Line** command is activated.

2. **Place** the match mark line where the reference file(s) have been clipped, see the CT_CSHT_Clipping_Boundary shape, which was placed when the plan sheets where created. (Section 3.2.1)

![Match Mark Line & Text](image2.png)

**Figure 85 - Match Mark Line & Text**

3. Next place the **Match Mark Text**, this task activates the **Place Active Cell command**. Place the cell, move and rotate as needed.

4. This cell has a link attached, this is used in conjunction with the project explorer to manage match marks, reference notes and drawing numbers, please see: [http://www.ct.gov/dot/lib/dot/documents/aec/cad_selectseries/project_explorer_and_detailing.pdf](http://www.ct.gov/dot/lib/dot/documents/aec/cad_selectseries/project_explorer_and_detailing.pdf)

Links make it easy to add or delete sheets and renumber all notes pertaining /referencing to other sheets. It can be very helpful and the user is encouraged to learn how to use it properly.
Section 5  **Project General Set**

Each project plan set has a title sheet, one or more section title sheet(s) and location map(s) associated with the project; general set, see DDE Guide. These sheets and map(s) are necessary to give an overview to viewers of the project location and length.

### 5.1 Title Sheet

Just as every book has a cover, the title sheet is the cover page for a DOT project plan set that conveys to viewers information about the project. The title sheet identifies the subsets of plans, conveys the general type of work planned, and locates the project within the State.

The title sheet includes:

- Project Title
- Town(s) and/or City(s)
- Route Number and Length
- F.A.P. number
- Project number
- Connecticut Map & Town Map
- Location Plan
- List of Subsets
- Signature Fields
- Total number of plan sheet

It is important that the Title Sheet is created early in the design process, so it can be attached to concept plan sets, preliminary plan sets and all other required/needed plan sets. The title sheet should be kept up to date at all times. The signature fields are not required until FDP submittal or as required by the Digital Project Development Manual (latest version). The title sheet is standardized and No modifications should be made other than the edits needed.
Before the Project Title sheet is created, the TRU map(s) for the town(s) where the project is located need to be copied into the Project container (folder).

1. Using Windows Explorer, locate the latest TRU map for the town(s) of your project, usually on the T-drive, Figure 86. If not mapped, map the drive to your computer; ask Helpdesk should you need help.

![Figure 86 - TRU maps drive](image)

2. Find the map for your town(s) by town number and Copy this file into your project directory under “X:\123_4567\Raster_Reference_Files”. Other units have access permission to this folder and can use the TRU maps for the project if needed. The files will not be copied twice or more often into the project directory.

Note: Any raster files from google map, aerials or other should be stored in this folder likewise.

5.1.1 Creating a Project Title Sheet

The Title Sheet for each project is created by the lead discipline (unit); see the Departments “Digital Project Development Manual” for the most up-to-date instructions.

When Highway Design is the lead unit, Highway Design is responsible to create the Title Sheet and assign the Subset numbers for each of the disciplines. Subset numbers 01 & 02 are reserved for General and Revisions respectively. Next subset number 03 is for the lead unit, in our case Highway Design. Other subset numbers follow as needed. The lead discipline’s project engineer should notify the other disciplines of the subset numbers assigned, please follow the DDE Guide.
1. Creating a project title sheet, within MicroStation click on the New File icon. Click on the Browse button to select the CT_Title_Sheet.dgn seed file.

W:\\Workspace\Standards\seed\CT_Title_Sheet.dgn

2. Type in the title sheet name using the file naming convention from the DDE Guide, HW_MSH_1234_1234_TSH.dgn. Click on Save.

3. Fit View when the new title sheet file opens. Follow the directions to the right of the title sheet border, see Figure 87.

4. Using the Text Edit command, edit the Project Title and the Town Name in the center of the sheet and in the bottom right box. Text in orange color needs to be edited.

5. Turn off the levels for items not needed, such as preliminary or semi-final design review, etc. Text in blue needs levels turned off as needed.

6. In the location plan area (Figure 88), turn off the district maps and reference in the TRU map copied into your project directory – Raster_References_Files, move, scale and clip to show the location of your project area. Annotate as needed. Also see Section 5.1.2. – Creating a Location Plan.

Figure 87 - Title Sheet (unedited)
7. **Reference** in the TRU map(s) as Town map(s), **scale** and **move** to under the **Maintenance Responsibility note**. **Turn Off** unneeded levels for the TRU map, see Figure 89.

8. **Shade in** the Town(s) in the Connecticut map; follow the directions to the right of the title sheet (Figure 87).

9. **Edit** the General Notes as needed.

---

**Figure 89 - Title Sheet (completed)**
5.1.2 Creating a Location Plan

The location plan depicts the approximate area(s) of the project location(s); in most cases on the title sheet. When a project has multiple locations or towns or is particularly long, an extra plan border sheet is used as location plan and as part of the General Sub Set for the project.

1. When the location plan fits on the title sheet, reference in the TRU map as stated in the directions located left of the title sheet. Move, clip and scale the TRU map as needed. The location map should be scaled so road names etc. can be read (Figure 89). The Project Location Cell is used to mark the project location.

2. When the project is very long or has multiple locations a separate plan sheet for a location plan should be prepared. Create a 2D Detail Sheet Model, as shown in Section 4.1. Name the sheet: HW_MSH_1234_1234_LOC.dgn.

3. Reference in the TRU map(s) for the project.

4. Use the Task for Begin and End Project to show the limits of the project, include a North arrow to orient the viewer. You can also thicken or draw a line to better show the project limits.

Figure 90 - Location Plan

5. Fill in the plan border title block, use Location Plan as title; include this sheet in the general subset under the list of drawings.
5.1.3 Creating Detailed Estimate Sheet

The Detail Estimate Sheet is part of the digital contract plans under the General Discipline subset and it contains all the pay items and quantities associated with the construction cost of a project. The lead designer usually creates the detail estimate sheet(s) and includes the detail estimates of other disciplines when required.

1. Create a new file using the seed file:  
   W:\Workspace\Standards\seed\CT_Sheet_Arch_2D_V8.dgn.

2. Type in the name using the Highway Design CAD File Naming convention from the CTDOT_DDE_Guide, example: HW_MSH_1234_1234_EST-01.dgn; click Save, Fit View.

3. Next open the detailed estimate excel file. As example open: 123_123_Estimate.xlsx.


5. In MicroStation click on Edit → Paste Special... . For Data Type select Linked Microsoft Excel Worksheet. Click Paste.

6. In MicroStation view select the lower right corner and the upper left corner for the placement of the linked excel file, ie. Detailed Estimate sheet. See Figure 91.

Figure 91 - Linked Detail Estimate Sheet (Excel file)
7. **Fill** in the border title block as before and **turn off** the levels in the title block as needed. Select **File** and **Save Settings**.

8. When printing select **Monochrome** as printing color.

### 5.1.4 Creating a Subset Cover Sheet

Each Discipline creates its own subset cover sheet, as an Index of Drawings. The lead designer / project manager (see [Digital Project Development Manual](#)) should provide the subset numbers to all other involved disciplines.

1. **Create** a New File using the seed file: `CT_Sheet_Arch_2D_V8.dgn`. *(W:\Workspace\Standards\seed\CT_Sheet_Arch_2D_V8.dgn)*

2. **Type** in `HW_MSH_1234_5678_INX-01.dgn` as file name; see File Naming Convention in the DDE Guide - Appendix C. Can also be located in **MicroStation** → CTDOT 2007 Utilities → Workflows & Docs → File Naming Conventions, see Figure 92.

3. The file has the plan border cell already placed.

4. **Click** on **CT DOT Sheet Composition**, then **Common Borders**.

5. **Click** on the task – **Index of Drawings Table**, Figure 93.
6. **Place** the cell origin at the bottom left corner of the plan border. (Figure 94)

![Subset Cover Sheet](image1)

Figure 94 - Subset Cover Sheet

7. Use the Contract Sheet Annotation tasks “General Notes” to fill in the **Drawing Number** and **Drawing Title** for your subset.

![Index of Drawings](image2)

In the **DDE** – Appendix C covers *File Naming* and Appendix D.7 covers *Drawing No. Prefix* for Highway Projects etc.
Section 6  Dimensioning

Tasks are available to simplify the adherence to the CTDOT CADD Standards for dimensioning.

Three tasks only set the correct levels and symbology for the dimension, the user has to use the dimensioning tools to place the dimensions. The ROW Hexagon task places text with a hexagon around the letter and with the correct level and symbology.

6.1  Right Of Way

All Right Of Way dimensions and the ROW Hexagon should be in the 2D Design Model in accordance with the Policies & Procedures for Property Maps and the CT DOT CAD Standards as prescribed below. The property map unit should be consulted when there are discrepancies between the two manuals.

6.1.1  ROW Hexagon

ROW Hexagon is under the ROW tasks for Highway, it is typically placed at the property, close to the property owners name in the 2D design model and at the ROW legend on the plan sheet.

The ROW Hexagon consists of a hexagon around a letter and each hexagon corresponds to a right or easement in the ROW legend.

1. **Activate** the ROW Hexagon task. Ensure the Place Callout button is active.
2. **Type** in the letter corresponding to the Right, Acquisition or Easement in the Text Editor.
3. **Place** the hexagon where needed; at the property owners name and at the ROW legend, Figure 96.
4. Repeat steps 1, 2 and 3, but place the hexagon at the legend with the corresponding right or easement note. See Figure 97

Figure 96 - ROW Hexagon in 2D Design File

Figure 97 - ROW Hexagon at ROW legend
6.1.2 ROW Linear

To dimension Row lines follow the Policies and Procedures for Property Maps manual. Invoke the task: Set Level for ROW Dimension and dimension the right of way lines as needed.

6.2 Lane Dimension

All dimensioning for lanes should be in the plan sheets.

1. Invoke the Set Level for Lane Dimension task. This sets the correct symbology for your dimensioning.

2. Next from the Dimensions – Main Task tool box select the Dimension Linear tool.

Figure 98 - Dimensions Toolbox
3. In the Linear Dimensioning dialog box set the Alignment to True and then click the magnifying glass to open the *Dimension Style* dialog box, see Figure 99.

![Figure 99 - Linear Dimensioning](image)

4. In the Dimension Style dialog box, go to the *Units* tab. Set the Units *Accuracy* to 0.

![Figure 100 - Dimension Styles box](image)
5. In the plan sheet click where the extra lane starts using key point snap. Then click on the center line and station using the intersect snap. Click to determine how far the dimension will extend. Click one more time to place the number value for the lane dimension. At this point you can stop (reset) or you can add another dimension. Follow the MicroStation Command Prompts on the bottom right corner. See Figure 101.

![Figure 101 - Placing Linear Dimension](image)
6.3 Roadway Dimension

The “Set Level for Roadway Dimension” is used when various items for the roadway needs to be dimensioned such as guiderail offset, guiderail length or offset for a structure etc. As example we will dimension guiderail.

1. Select the Set Level for Roadway Dimension.

2. Invoke the Linear Dimension tool. Again click on the magnifying glass and change the accuracy to 0.

3. Starting the dimension by clicking at the centerline for the culvert using intersect snap, extend to the start of the guiderail offset. Click to define the length of dimension extension line. Click one more time to place the number value (length of rail). Now either continue the dimensioning by typing in: “RE” and Enter. This rotates the dimension to the offset element and you can dimension the next length. Or click Reset (right mouse button) to end the command.

4. Next dimension the offset, click at the end of guiderail offset. Click on the edge of travelway line (perpendicular to the guiderail), define the length of dimension extension line and place the number value. Reset. Repeat for the end anchor offset. See Figure 102.

Figure 102 - Roadway Dimension